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Installation 

Chapter 1 
Installing Financial Link 
Professional 
 

This chapter introduces you to Financial Link Professional, and 
covers the installation procedure.  

What is Financial Link? 
 Financial Link Professional is a financial report designer that 

works with your ACCPAC Advantage Series, ACCPAC Pro 
Series, or ACCPAC Plus General Ledger data to create 
presentation-quality statements and reports.  

 When you start Financial Link Professional, it retrieves posted or 
provisionally-posted General Ledger data from the ACCPAC 
General Ledger that you are using.  

Methods of report 
creation 

Using retrieved General Ledger data, you can create reports and 
financial statements in a variety of ways:  

■ Using a predesigned template shipped with Financial Link 
Professional. 

■ Using one of the sample reports shipped with Financial Link 
Professional. (Financial Link comes with 16 sample reports 
for ACCPAC Advantage Series and ACCPAC Pro Series.)  

■ Creating a report or statement from scratch. 

■ Copying an existing Financial Link statement. 

■ Converting ACCPAC Plus report specifications files. 

Report parameters Once you build parameters for reports and statements, you can 
apply them to different periods, departments, or companies. 
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Formatting options Powerful formatting capabilities allow you to get creative with 
financial statements and reports without the risk of jeopardizing 
the integrity of your data.  

All the fonts available in Windows can be used in Financial Link 
Professional reports and statements. You can apply boldface, 
italics, underlining, borders, shading and colors. Financial Link 
Professional gives you control over page formats, margins, 
figure formats, percentages and currency symbols.  

Full departmental 
reporting  

Financial Link Professional offers full departmental reporting. 
You can include data from several different databases in the 
same report, and produce reports and statements for grouped 
departments, divisions and other account segments. 

You can create account groups for reporting purposes, even if 
the account numbers are not consecutively ordered.  

Create multiple sets 
of statements and 
reports  

You can create multiple sets of statements for a group of 
companies for corporate consolidations, or you can consolidate 
sales areas into one divisional statement.  

Drilldown capability Use Financial Link's drilldown feature on your data to view 
underlying transactions and subtotals. When you select an 
ACCPAC value and open a Drilldown Type window to display 
transaction details, Financial Link Professional opens an 
ACCPAC General Ledger Journal Entry Inquiry window. This is 
the same window that appears if you double-click a transaction 
in the General Ledger Transaction History window.  

View underlying data 
properties 

Double-click on any cell in a report or statement to see 
underlying data properties displayed.  

Use formulas Use formulas for calculating variances and percentages, use 
mathematical functions such as absolute, sum and average, work 
with constants you have defined, calculate currency rates, 
perform queries and design statements such as recurring 
financial ratio reports.  

Paste and export You can copy and paste formatted statements into Microsoft 
Excel or Word, and you can export financial statements to 
HTML format. 
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Installation 

Installing Financial Link Professional 
Activation code Before you install Financial Link Professional, you need an 

activation code.  

To request an activation code, you need to: 

■ Fill in the form that comes in the Financial Link Professional 
installation program, and e-mail or fax it to ACCPAC 
International, Inc. We will e-mail or fax back your code. 

 Or 

■ Fill in the Activation Request Form at our Web site, 
www.accpac.com. If you choose this option, we will e-mail 
back your code. 

For detailed instructions on requesting an activation code, see 
the section “Getting Activation Codes for ACCPAC Plus 
Accounting Applications,” in Chapter 1 of the System Manager 
User Guide. 

Use the same 
company name for 
activation 

Note that you must use exactly the same company name that you 
used when you requested the activation code. If the company 
name is different on the Activation Request form, the activation 
code will not work. 

To install Financial Link Professional: 

1. Start Microsoft Windows, and make sure there are no 
applications running. 

2. Insert the install disk in your CD-ROM drive. 

3. If you are using Windows 95 or higher, choose Run from the 
Start menu of the task bar in Windows 95, 98, or NT.  

4. If the installation screen does not start automatically, type 
d:\setup, then press Enter, where d is the drive letter of your 
CD-ROM drive. 

Follow the instructions on the screens that follow. You must 
identify the drive where program files will be installed, and the 
path (that is, the drive, directory, and file extension of your 
data). 
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Note:  If you are using ACCPAC Advantage Series, you must 
set up the “Financial Reporter” security resource in G/L security 
for all users other than the administrator who require access to 
the ACCPAC database from Financial Link. 

Where to Now? 
This guide is organized into five chapters and an appendix. 

Chapter 2, Getting Started, provides an overview to Financial 
Link Professional, from opening the application to exploring the 
desktop, viewing sample statements and converting ACCPAC 
Plus report specifications. 

Chapter 3, Working with Templates, describes the templates 
shipped with Financial Link Professional, shows you how to 
open and preview templates, and apply them to your 
statements. 

Chapter 4, Tutorial, provides a hands-on, step-by-step guide to 
creating statements. This chapter is organized in a series of 
lessons that are easy to follow and build on one another to create 
a professional, print-ready Income and Expense statement. Once 
you have completed these lessons, you will have a strong 
knowledge of the basics. 

Chapter 5, Working with Statements, offers reference 
information on various aspects of working with Financial Link 
Professional, including formatting statements, setting print and 
preview options, working with databases and data properties, 
customizing defaults, setting up account segments, account 
groups and folders.  

Appendix A, Financial Link Administration, describes how to 
administer user access and use the Signon utility. 
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Chapter 2 
Getting Started 
 

This chapter is designed to help you get up and running in 
Financial Link Professional.  

Startup Instructions 
ACCPAC or ACCPAC 
Plus General Ledger 
data 

You can use Financial Link Professional with General Ledger 
data in ACCPAC, ACCPAC Plus, or both.  

Because the startup procedure is slightly different depending on 
which ACCPAC product you work with, this section is divided 
into two parts:  

■ Working with ACCPAC Data. 

■ Working with ACCPAC Plus Data. 

Working with ACCPAC Data 

Follow this set of startup instructions if your General Ledger 
data is in ACCPAC.  

Step 1.  Launch Financial Link Professional. 

You launch Financial Link Professional from the Windows Start 
menu, by selecting Programs, then Financial Link Professional. 
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The Welcome Window appears as a guide to help you get 
started: 

Welcome window for 
ACCPAC data 

 

Step 2.  Choose a Welcome option. 

Choose an option Choose from one of four options in the Welcome window:  

■ Get a quick introduction and overview.  Click this option 
to view an online help file that provides a product overview.  

Financial Link Professional displays an online help 
introduction in a separate Help window while the Welcome 
window remains in the background.  

After you finish reading the introduction, close the window 
by selecting Exit from the File menu, and choose another 
Welcome option. 

■ Start a new set of reports and create statements from 
templates.  Click this option to use a predefined template 
for creating statements. 

■ Start a new set of reports and convert ACCPAC 
specifications.  Click this option to convert ACCPAC Plus 
report specifications. 

■ Open an existing set of reports.  Click this option if you 
want to work with an existing report set. 

Tip:   We recommend you choose the second option, Start a new 
set of reports and create statements from templates, to get 
up and running quickly. 
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Click OK. The Welcome window disappears.  

If you want to 
suppress the 
Welcome window in 
future 

If you do not want to use the Welcome window, check the 
option, Don’t show this screen again. To re-display the Welcome 
window, go to the Help menu and select Show Welcome on 
Start. Each option that appears in the Welcome window can also 
be launched through the menus on the Financial Link 
Professional desktop. 

Step 3.  Connect to your General Ledger data. 

The New Database window prompts you to specify which 
ACCPAC product you wish to work with:  

New Database 
window 

 

Click on ACCPAC, then click OK. 

 
The New Database window closes, and the Database Location 
window appears:  

Database Location 
window 

 

Step 4.  Specify the location of your data. 

Use the Selector arrow to see a drop-down list of company 
databases to choose from, click on one and click OK. Financial 
Link Professional looks to see what companies you have in the 
Registry. 
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The Maintain Databases window shows the database you 
selected, along with other details about this database. 

Maintain Databases 
window 

 

Click Close. For more information about this window, refer to 
“Working with Databases,” in Chapter 5 of this guide. 

Step 5.  Sign on to your data. 

After you close the Maintain Databases window, a Signon 
window appears:  

Signon window for 
ACCPAC  

 

Sign on as a system administrator by entering ADMIN in the 
Initials and Password field, and click OK. As an alternative, use 
the user ID and password that has been provided to you. 

After you have signed on, you can work with Financial Link 
Professional. 



Startup Instructions 

User Guide    2–5 

FLP2.doc, printed on 09/29/2004, at 1:30 PM. Last saved on 06/11/2001 10:50 AM. 

ACCPAC INTERNATIONAL, INC. Confidential

G
etting S

tarted 
G

etting S
tarted 

Signon window The Signon window represents the Signon utility, which is 
designed for ACCPAC Options applications to ensure that your 
security access remains active while you are running Financial 
Link Professional or any other Options application. The Signon 
window appears each time you try to connect to a database. 

If your sign-on 
attempt fails 

If the sign-on fails, an error message appears, followed by the 
Maintain Databases window. In the Maintain Databases 
window, click the Location button to check that the entries below 
the Directory and Selector headers show the correct path to your 
data, and the correct company code. (If necessary, contact your 
system administrator for assistance.) Next, open the Signon 
window by clicking the Open button, and try to sign on again. 

Running more than 
one ACCPAC 
Options application? 

If you are running another ACCPAC Options application, you 
don’t need to sign on when you start Financial Link Professional. 
If you are running Financial Link Professional alone, the Signon 
window will appear every time you open a new or existing 
report set. When you exit all ACCPAC Options applications, you 
will be required to sign on again. 

Setting up the Signon 
utility 

Refer to Appendix A for more information about the Signon 
utility.  

Step 6.  Click OK at the Information window. 

After you have signed on to your data, an Information window 
reports how many segments Financial Link Professional 
automatically created, based on your General Ledger data:  

Information window 

 

Click OK. 

Startup is complete Now that you have connected to your data and signed on, refer 
to the section, “After Startup,” later in this chapter. 
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Exploring Financial 
Link Professional 

If you plan to explore the desktop’s Toolbar and menu options, 
refer to the section, “Exploring the User Interface.” 

Working with ACCPAC Plus Data 

Follow this set of startup instructions if your General Ledger 
data is in ACCPAC Plus.  

Step 1.  Launch Financial Link Professional. 

You launch Financial Link Professional from the Windows Start 
menu, by selecting Programs, then Financial Link Professional. 

The Welcome Window appears as a guide to help you get 
started: 

Welcome window for 
ACCPAC Plus data 

 

Step 2.  Choose a Welcome option. 

Choose an option Choose from one of four options in the Welcome window:  

These options are described in the previous section, “Working 
with ACCPAC Data,” in Step 2. 
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Step 3.  Connect to your General Ledger data. 

When the New Database window appears, click ACCPAC Plus, 
and click OK. 

New Database 
window 

 

The Database Location window appears: 

Database Location 
window 

 

Step 4.  Specify the location of your data. 

In the Database Location window, enter the path to your 
ACCPAC Plus data in the Directory field; the Selector field is a 
code assigned to your database. Click OK. 

If you don’t recall the path to your data, click the Browse button 
to find the folder which contains your ACCPAC Plus data.  
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The Find Dataset window appears: 

Find Dataset window 

 

Select the folder which contains your ACCPAC Plus data, and 
click OK. Back in the Database Location window, the folder you 
selected appears in the Directory field. Click OK. 

Step 5.  Sign on to your data. 

The Signon window appears: 

Signon window for 
ACCPAC Plus 

 

Sign on as a system administrator by entering SYS in the Initials 
and Password fields, and click OK. 

After the Signon window closes, an Information window 
appears to show how many segments were created: 

Information window 
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Click OK. The Maintain Databases window appears: 

 

Click the Close button. 

Startup is complete Now that you have connected to your data and signed on, you 
are ready to work with the Financial Link Professional desktop, 
explore menu options and Toolbar buttons, open sample reports 
and templates. 

After Startup 

To work with a 
template  

If you chose the Welcome window option, Start a new set of 
reports and create statements from templates, see Chapter 3, 
“Working with Templates” for details. 

To work with a blank 
statement  

If you chose the second option but want to work with a blank 
statement rather than a template, see the tutorial in Chapter 4 for 
steps on building a statement from scratch. 

To convert ACCPAC 
Plus specifications 

If you chose the third option in the Welcome window, Start a 
new set of reports and convert ACCPAC specifications, see 
the following section, “Converting ACCPAC Plus Report 
Specifications.” 

To open an existing 
report set or 
statement 

If you chose the fourth option in the Welcome window, Open 
an existing set of reports, see the section, “Working with 
Report Sets,” in Chapter 5, “Working with Statements.” 



Converting ACCPAC Plus Report Specifications 

2–10    Financial Link Professional 

FLP2.doc, printed on 09/29/2004, at 1:30 PM. Last saved on 06/11/2001 10:50 AM. 

ACCPAC INTERNATIONAL, INC. Confidential

Converting ACCPAC Plus Report Specifications 
If you want to create a report using your ACCPAC Plus report 
specification files, follow the steps in this section.  

To convert specifications: 

1. The Convert Specifications window automatically appears if 
you choose the third option in the Welcome window. 

If you have completed the startup instructions and do not 
see the Convert Specifications window, choose File > New 
Statement > From ACCPAC to open the Convert 
Specifications window, shown here:  

Convert 
Specifications 
window 

 

2. Select the specification file(s) that you want to convert. Click 
the Change Directory button to find a specification file 
stored in a folder that is different than the default directory 
that appears.  

3. Click OK.  

4. The Add to Folders window appears:  

Add to Folders 
window 

 

All Databases folder Financial Link Professional sets up one folder called All 
Databases.  
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5. Select the folder(s) that will hold your converted statements. 
To select more than one folder, hold down the Ctrl key and 
click each folder. Then, click OK. 

Note:  You need to complete this step for every specification 
file that you selected, unless you check the option, Continue 
to Use these Settings for each Statement. 

After you convert 
specifications 

After you convert an ACCPAC Plus specification, a new 
statement is set up under the specified folders. 

6. In the Financial Reports window, double-click the 
statement’s name to open it.  

The Statement Design window shows the statement you 
have converted. This example shows budgeted net changes:  

Example of a 
converted statement 

 

Formatting converted 
statements 

To explore formatting options for your converted statement, 
refer to the section, “Formatting Reports and Statements,” in 
Chapter 5,  “Customizing Statements.” 

Code Conversion Problems 

If Financial Link Professional cannot convert one or more 
specifications codes, a “Conversion Warnings” window appears 
showing the specification file line(s) that could not be converted 
as well as the statement row(s) affected. 

See Readme file Refer to the Readme file shipped with Financial Link 
Professional for corrective action to take.  
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Exploring the User Interface 

About the Desktop 

 The Financial Link Professional desktop, shown here, offers a 
menu bar and a Toolbar as well as a backdrop for statements you 
open: 

Financial Link 
Professional Desktop 

 

Toolbar A Toolbar is an assortment of buttons for performing tasks. 
Financial Link Professional offers a standard Toolbar and a 
Design Toolbar.  

Toolbar buttons let you open, save, print and preview files, 
undo, cut, copy and paste your work, create a new statement, 
and apply formatting options. 

Standard Toolbar 
 

To see ToolTips Place your mouse pointer over Toolbar buttons to see button 
names appear in yellow boxes.  
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Design Toolbar 
button 

Click the Design Toolbar button to show the Design Toolbar, 
which offers additional formatting buttons that allow you to 
change font characteristics, alignment, margins, cell sizes, outline 
cells and add borders: 

 

 
The Fiscal Period Selector and Fiscal Year Selector allow you to 
change the reporting period and year quickly. Statement 
balances are automatically recalculated based on your selections. 

You can change the statement reporting period and year from 
the main menu bar by selecting Fiscal Year from the Global 
menu. If you have fiscal period ends that do not agree with 
normal month end dates, change the reporting date by selecting 
Statement Date from the Global menu.  

 
Help button Click the question mark button, move the black question mark to 

a spot anywhere on the page and click the mouse to see an online 
help description. A description will appear if there is a Help 
topic available for that selection. 

Exiting the program To exit from Financial Link Professional, select Exit from the File 
menu. 

About the Financial Reports Window 

Folders Whenever you open a set of reports or create a set, the Financial 
Reports window automatically displays a folder with your 
company reports and financial statements. 

All Databases folder By default, whenever you create a new report set, the Financial 
Reports window displays a folder called All Databases. This is a 
consolidated folder for all accounts as well every segment or 
department defined in your ACCPAC or ACCPAC Plus 
database. 
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Folder icons Yellow file folder icons represent folders. If a folder contains 
statements, it displays a ‘+’ symbol. Click a folder to display a 
list of statements. Click it again to close it. You can rename 
folders as required. 

Financial Reports 
window 

 

Adding and deleting 
folders 

You can add folders and delete folders as required. For example, 
you can add folders to hold all month-end reports.  

How to open 
statements in folders 

Simply double-click a statement name in the Financial Reports 
window to open the statement. 

Exploring Sample Statements 
Financial Link Professional is shipped with sample statements 
based on ACCPAC Plus sample General Ledger data that 
Financial Link Professional installs. 

Sample report sets and statements are installed to the Financial 
Link Professional program directory (you can specify this 
program directory when you are installing Financial Link 
Professional). 

Exploring sample statements is a good way to become more 
familiar with the way Financial Link Professional works. 

To open sample statements: 

1. Choose Open Report Set from the File menu on the Financial 
Link Professional desktop. The Open window appears: 
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2. Change the directory to the location where your sample 
statements are stored, for example, <DRIVE 
LETTER>:3RDPARTY\FNWIN\SAMDATA, where 
<DRIVELETTER> is the drive where Financial Link 
Professional is installed. 

3. Select any .RPS file.  

For online help 
descriptions of 
sample statements 

See the online help for detailed descriptions of sample 
statements. From the Financial Link Professional’s Help menu, 
choose Contents.  

Exploring Statement Design Windows 
Each statement or report appears in its own Statement Design 
window on the Financial Link Professional desktop. 

The title bar at the upper left-hand of your statement shows the 
name of your statement along with the folder that it is stored in. 

Statement Design 
window 
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Parts of the Statement Design Window 

Status bar When you select a cell, the status bar at the bottom right-hand 
corner of the Financial Link Professional desktop displays 
information on a cell’s data properties, as shown here: 

 

Scroll bars Use the vertical and horizontal scrollbars to move to the far 
corners of your statement. 

Minimize, maximize 
and close buttons 

Use the minimize, maximize and close buttons at the upper-right 
hand corner of your statement to resize or close the statement 
window. 

 

 
Rearranging the 
window 

Reposition the Statement Design window to appear anywhere on 
the desktop by grabbing the title bar, and then moving the 
window.  

Pop-up menus Right-click on different parts of the statement to see a pop-up 
menu with options for formatting, defining data properties, 
copying and pasting parts of your statement, and using the drill 
down feature.  
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Options available on this menu depend on which part of the 
statement you select. Greyed-out options are not available for 
selection. 

Pull-down menus Use pull-down menus on the Financial Link Professional desktop 
for additional options. The Data and Format menus show 
statement-specific options when your cursor is in an open 
statement. 

Selecting statement 
contents 

Click the master cell at the top left of your statement to select 
your statement’s contents. Once selected, you can format and 
copy the contents as well as change data properties. 

Viewing cell 
information 

Double-click a cell to see underlying data properties in a Cell 
Information window, shown here: 

 

 

Online help Click on any part of the statement (for example, a column 
header, row header, or a cell) and press F1 to see an online help 
description appear. You can also explore online by topic.   

Renaming column 
and row headings 

You can rename column and row headings by right-clicking on 
the label and choosing Row Prop or Col Prop from the pop-up 
menu.  
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Where to Now? 
See Chapter 3, “Working with Templates,” to apply one of the 
several professional-quality templates shipped with Financial 
Link Professional. 

Read Chapter 4, “Tutorial,” to explore Financial Link 
Professional’s features by following step-by-step instructions on 
how to create a statement from scratch.  

To find out how to apply formatting and change default settings, 
read Chapter 5, “Working with Statements.” 



User Guide    3–i

FLP3.doc, printed on 11/16/00, at 10:31 AM. Last saved on 11/14/00 7:09 PM.

ACCPAC INTERNATIONAL, INC. Confidential

T
e

m
p

lates

Chapter 3
Working with Templates

Introduction ................................................................... 3–1
Viewing Templates ......................................................... 3–2
Applying Templates........................................................ 3–2

Where to Now? ................................................................ 3–6





User Guide    3–1

FLP3.doc, printed on 11/16/00, at 10:31 AM. Last saved on 11/14/00 7:09 PM.

ACCPAC INTERNATIONAL, INC. Confidential

T
e

m
p

lates

Chapter 3
Working with Templates

This chapter is designed to show you how easy it is to use
Financial Link Professional templates.

Introduction
Templates make designing reports and statements effortless. Use
one of six styles to transform your General Ledger data into
professional-quality reports and statements without manual
formatting.

There are six templates shipped with Financial Link
Professional:

� Professional Quality.  This template provides a formal
presentation-quality format best suited for annual reports,
business proposals or board of directors’ reports.

� Accountants’ Annuals.  This template produces financial
statements with current year and prior year columns.

� Traditional Format.  This template is designed for recurring
reports such as income statements.

� 12 Month / or Department Analysis.  This template is a
columnar presentation format for departmental or fiscal
period reports. You can choose to see the current month and
the previous eleven months of data.

� Financial Ratios.  This template produces statements
containing standard business ratios, such as liquidity, acid,
turnover and profitability ratios.

� Management Statements.  This template is designed for
statements that report performance measurements.
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Viewing Templates

You can view an example of each template by opening it from
the directory on the hard drive where you have installed your
templates.

Follow these steps to see your statement will look like if you
apply the template.

To open a sample report set:

1. Choose Open Report Set from the File menu.

The Open window appears:

2. Navigate to the directory that contains the templates:

<DRIVE LETTER>:3RDPARTY\FNWIN\SAMDATA

3. Choose any of the .RPS files in this directory to open the
sample report set.

4. Click OK.

Once your report set is open, you can resize or print the
statement.

Applying Templates

When it comes to working with templates, Financial Link
Professional presents a series of Templates windows that guide
you through each stage of the process with clear and simple
prompts.

You can achieve high-quality results quickly in a few steps.
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To apply a template to a statement:

1. If you have already opened a set of reports, go to the File
menu, and select New Statement> From Template.

If you have just launched Financial Link Professional, choose
the second option in the Welcome window, Start a New
Series of Reports and Create Statements from Templates.

The first in a series of Templates windows appears:

Templates window:
choose a template
style

2. Click on a template style in the Choose a Template Style list.

3. Click the Next button.

The Templates window now shows a Select Statements list:

Templates window:
select statements

4. From the Select Statement list, choose one or more
statement(s) to apply your template to.

5. Click the Next button.
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The Templates window now shows a Select Columns For
list.

Templates: select
columns

What appears in this list depends on your selections in
earlier steps.

6. From the Select Columns For list, choose one or more
column(s).

If the column type you want to use is not in the list, pick the
closest fit. Once the statement is created, you can change the
period balance columns to suit your reporting needs.

The Templates window continues to appear until you have
selected columns for each of the statements you selected in
step 4.

7. Click Next.

The Templates window shows a series of account codes,
their descriptions, and the accounts they apply to:

Templates window:
define account
groups
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8. Define the starting range by finding the row that
corresponds to the account group you want to work with,
then placing your cursor in the Acct column and clicking
once.

This column represents the starting number of the account
range you want to assign the group code to.

Select a large range We recommend you use reserve a large block of account
numbers in your ranges, such as 4000 to 4900, to ensure that
any new accounts you add will be incorporated into your
financial statements, and that your statements will balance.

9. In the Acct drop-down selection list, shown here, scroll to
find an account code, and click on it.

If you don’t find the account code you wish to use, you can
press the Escape key, click the empty cell, and type the
beginning account range you wish to use.

10. Define the end of your account range by repeating steps 8
and 9 for the last column. You can also define an account
group by clicking the  button to open the Acct Groups
window, and then selecting New.

11. Click the OK button.
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An Add to Folders window appears:

12. Select the folder that will hold your converted statement. To
select more than one folder, click and drag, SHIFT-click, or
CTRL-click.

Repeat this for each statement you have selected in step 3, or
select the option, Continue to Use These Settings for Each
Statement.

13. Click the OK button. Both the Add to Folders window and
the Templates window disappear.

Financial Link Professional displays the completed statement(s).

Where to Now?
If you want to build a statement without using templates, read
Chapter 4, “Tutorial.” This chapter provides a series of lessons
for creating an income statement with step-by-step instructions
for each stage of the statement-building process.

If you want to customize statements you have created using
templates or explore more advanced features, read Chapter 5,
“Working with Statements.” This chapter is designed as a
reference with topics that include working with default settings,
data properties, report sets, databases and folders, statement
design and formatting.
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Tutorial Overview 
In this chapter, you learn to create a simple three-column income 
statement from scratch.  

This tutorial is organized into twenty-two separate lessons 
which build on each other. Taking an open blank statement, you 
will learn how to insert rows, define row contents, apply 
formatting, use drilldown, finalize and print your statement.  

Before You Start 

The starting point for your tutorial is to create a new report set 
from the sample data included with Financial Link.  

Go to Lesson 1 if you have already opened a report set you want 
to work with for this tutorial. 

To open a new report set: 

1. In Financial Link, from the File menu, choose New Report 
Set.  

The New Database window appears: 

New Database 

 

2. Choose ACCPAC Plus, and click OK. 
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The Database Location window appears:  

Database Location 
window 

 

3. In the Database Location window, enter the path to your 
ACCPAC Plus data in the Directory field; the Selector field is 
a code assigned to your database. Click OK. 

If you don’t recall the path to your data, click the Browse 
button to open a Find Dataset window, where you can 
browse to find the folder which contains your ACCPAC Plus 
data.  

The Find Dataset window appears: 

Find Dataset window 

 

Once you have located the folder which contains your 
ACCPAC Plus data, click OK.  

Back in the Database Location window, the folder you 
selected appears in the Directory field. Click OK. 
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The Signon window appears. 

 

In the Signon window, enter SYS into the Initials and 
Password fields. 

4. Click OK. 

An Information window appears showing how many 
segments were created: 

Information window 

 

The Financial Link desktop now shows a Financial Reports 
window: 

Financial Reports 
window 
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Lesson 1:  Open a blank statement. 

� From the File menu, choose New Statement, and then 
Empty.  

A blank Statement window appears on your desktop: 

New statement 

 

Lesson 2:  Insert a column. 

1. Place your cursor inside the new statement, right-click on 
the right most box:  

Right-click the
right most box.

 

2. Choose Insert from the pop-up menu:  

Pop-up menu 
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The Data Properties window appears:  

Data Properties 
window 

 

3. In the Type section, select the Text option. 

4. In the Codes box, select Account. 

5. Click the Insert button to place the AcctName code in the 
Text Definition field. 

6. Click the Format button, and then click the Alignment tab: 

Format window 

 

7. Select the Left Justify option. Click OK. 

8. In the Data Properties window, click OK.  
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Your statement should display a new column that looks like 
this: 

New column 

 

If you make a mistake If you make a mistake inserting a column or row, click the name 
of the column or row and delete it by pressing the Delete key. 

Lesson 3:  Insert two more columns. 

1. In the Statement window, right-click the box to the right of 
the Text C1 cell.  

2. From the pop-up menu, select Insert. 

3. In the Data Properties window, go to the Type section, and 
select the Data option. 

4. In the Data selection list, click Selector. A Builder button 
appears in the Data Properties window.  

5. Click the Builder button. A Selector Builder window 
appears:  

Selector Builder 
window 
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6. Make sure that the following options are selected: 

a) Net change 

b) In actual 

c) Current period 

d) Current year 

e) Overlap 

7. Click OK. The Selector Builder window closes. 

8. Click OK again in the Data Properties window. 

If columns don’t appear in the Statement Design window, 
use scroll bars or widen the window to see them. 

9. Insert a third Data column to the right of the column Data 
C1. 

10. Select the following options in the Selector Builder window: 
Balance, Of Actual, Current Period, Current Year, Overlap. 

Note:  You may need to scroll to the right on the Statement 
window to find the end of the second column, which is 
named Data C1. 

Lesson 4:  Insert text rows 

Next, insert six text rows which will contain headings: 

1. In the Statement window, right-click the first row box and 
select Insert from the menu. 

 The Data Properties window appears. 

2. In the Type section, select the Text option, and leave the Text 
Definition field blank. 

3. Click OK.  
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The Statement Design window shows the row that you 
created, labeled Text R1:  

 

4. Right-click the Text R1 box, and choose Copy from the 
menu. 

5. Right-click the box below the Text R1 box, and choose Paste 
from the menu. 

6. Repeat step 5 four times, pasting a row under the last one. 

Your statement will contain six row boxes, labeled Text R1 to 
Text R6: 

 

Lesson 5:  Create and format headings. 

1. Click the cell on row Text R1 and column Text C1.  

2. Right-click and choose Cell Prop from the menu.  

The Data Properties window appears. 

3. In the Type section, select the Text option. 

4. In the Use Text Definition Of section, select the Specified 
option to clear the Text definition field. 

5. In the Codes box, select CompanyName. 

6. Click the Insert button.  
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Financial Link inserts CompanyName in the Text Definition 
field, as shown:  

 

 

7. Click the Format button to format the title. The Format 
window appears. 

8. Click the Alignment tab, and choose Center for both the 
horizontal and vertical alignment.  

9. Select Statement as the Span type. 

10. Click OK.  

11. In the Data Properties window, click OK.  

The company name appears in the Statement Design window:  

 

Add second heading Now follow these instructions to specify another heading: 

1. Click the cell on row Text R2 and column Text C1. 

2. Repeat steps 2, 3, and 4 of the previous procedure. 
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3. In the Text Definition field, type “Income and Expense 
Statement”. (Omit the quotation marks.) 

4. Click the Format button. 

5. On the Format window, click the Alignment tab, and select 
Center for both horizontal and vertical alignment. 

6. Click Statement as the Span type option. 

7. Click the Borders and Font tab. 

8. Change the font size to 8. 

9. Click OK.  

10. In the Data Properties window, click OK. 

Add third heading To create a third heading for Text R3, Text C1 (third row, first 
column), follow these steps: 

1. Click the cell on row Text R3 and column Text C1. 

2. Right-click the selected cell, and choose Cell Prop. The Data 
Properties window appears. 

3. In the Type section, select the Text option. 

4. In the Use Text Definition set of options, select the Specified 
option. This clears the Text Definition field. 

5. In the Text Definition field, type “for the “ with an extra 
space. 

6. In the Codes selection list, select CurrentPeriod. Several 
choices appear in the Formats selection list. 

7. In the Formats list, select one.  
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The Data Properties window looks like this:  

 

 

8. Click Insert. 

9. In the Text Definition field, type “ periods ended “ at the end 
of the line. Include the extra spaces, but omit the quotation 
marks. 

10. In the Codes selection list, select StatementDate. 

11. In the Formats list, select mm/dd/yy, and click Insert. 

12. In the Text Definition field, change 
{StatementDate:mm/dd/yy} to read {StatementDate:mmmm 
dd, yyy}.  

13. Click the Format button. 

14. In the Format window, click the Alignment tab. 

15. Choose both Center alignment options. 

16. Select Statement as the Span option. 

17. Click OK in the Format window and in the Data Properties 
window. 

Lesson 6:  Apply boldface to headings 

Apply boldface Next, format each heading to appear in boldface.  
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1. In the Statement window, drag the mouse pointer to select 
the first two cells under column Text C1, which show the 
name of your company and the name of the statement. Once 
selected, the cells will show a border of blue dots. 

 
 2. If the Design Toolbar button is not selected, then click it. 

3. Click the Bold button on the toolbar.  
  

4. Click the cell that intersects Text R6 and Data C1, then 
right-click, and choose Cell Prop from the pop-up menu. 

5. In the Data Properties window, in the Use Text Definition Of 
section, select the Specified option. 

6. In the Text Definition field, type “Current Period” and omit 
the quotation marks. 

7. Click OK. 

8. Select the cell that intersects Text R6 and Data C2, then 
repeat steps 4 through 7; for step 6, type “Year to Date”. 
(Omit the quotation marks.) 

9. Drag the mouse to highlight the entries Current Period and 
Year to Date. 

10. Right-click, and select Format from the menu. 

11. In the Format window, click the Alignment tab. 

12. Select Center for both the Horizontal and Vertical alignment 
options. 

13. Select the Borders And Font tab. 

14. Select the Bold option, and click OK. 

Lesson 7:  Set number formats. 

1. Click the gray cell in the upper left corner of your statement.  

2. Right-click, and select Format from the pop-up menu. 

3. In the Format window, click the Figures tab.  

4. In the Source section, select the Default Currency option. 

5. In the Custom Settings section, select Leading from the 
Negative selection list.  
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6. Select ( ) in the next field. 

7. Check the Space option. 

8. Next to the Currency field, remove the $ sign. The Format 
window looks like this: 

 

9. Click OK. 

Lesson 8:  Insert a data row. 

1. Right-click the gray cell on the row below Text R6, and 
choose Insert from the pop-up menu.  

2. In the Type section, select the Data option, then Account. 

3. In the field below the Unspecified option, select 4000 Sales 
(the first revenue account). In the To field, select 
4350 Revenue, Warehouses (the last revenue account). 

The Data Properties window looks like this: 
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Note:  If you need to exclude an account or include an 
account from another area of your chart of accounts, choose 
the Groups button to customize the range. 

4. Select the Consolidated option. 

5. Click the Format button. The Format window appears. 

6. In the Format window, click the Figures tab. 

7. Check the Sign Reversal option. 

8. Click OK in the Format and Data Properties windows. 

9. In the Statement Design window, double-click the cell 
labeled Sales, and change the Text field to “Revenue”. 

10. Click OK. 

11. Click the Yes button to confirm the name change.  

Lesson 9:  Insert another data row. 

At the bottom of your statement, insert another Data row for the 
cost of goods sold according to the instructions covered in 
previous steps. Instead of Revenue, specify Cost of Goods and 
select accounts 5000 to 5500 in the Data Properties window.  

The Data Properties window looks like this: 
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Your statement now shows a row for cost of goods sold: 

 

Lesson 10:  Insert a row for gross margin. 

Insert another row at the bottom of the statement to hold your 
gross margin total: 

1. In the Data Properties window, change the Type to Total. 

2. In the Totals section, select the Above, Start, and Data Cells 
options. 

3. Click the Format button, and select the Sign Reversal option 
in the Format window. 

4. Click OK in the Format window. 

5. Click OK in the Data Properties window. 
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6. In the statement design window, double-click on the cell that 
intersects Total R1 and Text C1. A Cell Information window 
appears:  

Cell Information 
window 

 

7. In the Cell Information window, type “Gross margin” in the 
Text field. (Omit the quotation  marks.) 

8. Click OK, and then click Yes to confirm the change.  

Your statement should appear as follows: 

 

Lesson 11:  Increase the row height. 

1. Click the gray Total R1 label of your Gross Margin total row.  

 

2. Place the mouse pointer on the bottom border of the Total R1 
label. The mouse pointer should resemble a double line with 
arrows pointing up and down. 

3. Drag the line down a bit to insert space between the total 
line and the rows above. 
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4. Right-click on the gray Total R1 label, and select Format 
from the pop-menu. 

5. On the Alignment tab, select Bottom for vertical alignment. 

6. Click OK. 

Lesson 12:  Insert a blank row. 

1. Insert a new row under the Total R1 row.  

2. In the Type section of the Data Properties window, select 
Text. 

3. Accept all the default settings, and click OK. 

Lesson 13:  Insert expense heading and account row. 

1. Double-click the cell that intersects Text R7 and Text C1, and 
type “Expenses” in the Text field.  

2. Click OK, and Yes to confirm the change. 

3. Insert another row for data. 

4. In the Data Properties window, and in the Type section, 
select Data. 

5. Click the Acct option. 

6. In the fields in the Account section, select accounts 
6000 Accounting And Legal Fees to 9100 Corp. Income 
Taxes – Deferred. 

7. Select the Separated option to ensure that the expense 
accounts will be listed separately.  

8. Click the Format button. 

9. In the Format window, click the Alignment tab. 

10. In the Margins section, type 0.15 in the Left field. 

11. Click OK in the Format window. 

12. Click OK in the Data Properties window. 

The accounts you selected in step 6 appear in your statement.  
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Lesson 14:  Suppress and format zero balances. 

Handling zero 
balances 

In this step, you will set up options for handling zero balances to 
hide rows with zero balances in both data columns.  

1. Right-click the gray cell at the top left corner of your 
statement (to select your entire statement and show a menu). 

2. Select Format from the menu, and click the Row tab. 

3. In the Suppression drop-down list box, select the option, If 
Zero: 

 

4. Click the Borders And Font tab. 

5. In the Display Zeros As field, select the dash. 

6. Click OK.  

Lesson 15:  Add a row to total expenses. 

 In this step, you will add a row at the bottom of your statement 
for totals to appear.  

1. Insert a row at the bottom of the financial statement. 

2. In the Data Properties window, change the Type to Total.  

3. In the Totals section, select the Above and Previous Total 
options. 

4. Check the Data Cells option. 

5. Click OK. 
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Lesson 16:  Insert a row for formulas. 

1. Insert another row at the bottom of your statement.  

2. In the Data Properties window, in the Type section, select 
the Formula option. 

3. In the List section, select the Rows option. (The Data 
Properties window shows labels from the statement in the 
box to the right.) 

4. Select Total R1 from the box, and then click the Add button. 

 
Plus Sign 
button 

5. From the row of buttons at the bottom of the window, click 
the Plus button.  

6. To complete your formula, select Total R2 from the list, and 
click the Add button. 

7. Click the Format button, then click the Figures tab. 

8. Check the Sign Reversal option, and click OK. 

9. Click OK on the Data Properties window. 

10. Double-click the cell that intersects Formula R1 and Text C1. 
In the Text box, type “Net Profit”. (Omit the quotation 
marks.) 

11. Click OK, and then click Yes to confirm the change. 

Lesson 17:  Add a dollar sign to figures. 

This step shows you how to add a dollar sign to your figures.  

 1.  Select your revenue data figures by dragging over them: 

 

2. Go to the Format menu on the desktop and choose Figures. 
The Format window appears. 

3. In the Source section, select the Default Currency option. 

4. In the Custom Settings section, in the Currency field, select 
Left. 

5. Check the Outside Neg option. 

6. Click OK. 
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The figures you selected will show a dollar sign to the left.  

7. Repeat steps 1 to 5 to add a dollar sign to Net Profit figures, 
but leave the Format window open. 

Lesson 18:  Apply formatting. 

1. In the Format window, click the Borders and Fonts tab.  

2. In the Borders section, choose a solid line for the top border, 
and a double line for the bottom border.  

3. In the boxes to the right of the border options, choose the 
Inside option. The Format window looks like this: 

 

4. Click OK. 

Lesson 19:  Re-align the net profit row. 

 Change the height and alignment of the Net Profit row as 
follows:  

1. Right-click the gray Formula R1 label to select the row. 

2. Select Format from the pop-up menu.  

3. In the Format window, click the Row tab. 

4. In the Height field, type 0.35. 

5. Click the Alignment tab, and set the vertical alignment to 
Bottom. 

6. Click the Borders and Font tab. 
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7. Check the Bold option. 

8. Click OK. 

Lesson 20:  Rename the financial statement. 

1. From the Data menu, select Statement Prop. 

2. In the Data Properties window, in the Data Properties for 
Statement field, change the statement name to “Income and 
Expense statement”. (Omit the quotation marks.)  

3. Click OK. 

Final Income and 
Expense statement 

You now have a complete Income and Expense statement you 
can use.  

By advancing the period using the Fiscal Period selector from 
the main toolbar, you can re-use the statement repeatedly. 

Lesson 21:  Print your financial statement. 

1. Select Print Preview from the File menu.  

The Print Mode window appears:  

 

2. Select the option, “Statement ‘Income and Expense’ 
statement. 

3. Click OK.  
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The printed income and expense statement appears in a 
Print Preview window.  

 

4. Click the Print button, and then click OK to print. 

Options For viewing and printing options, click the buttons on the bar 
above the report. Financial Link Professional uses your Microsoft 
Windows setup options, including portrait and landscape 
orientation and network print configuration. 

Lesson 22:  Drill down to view the underlying transaction. 

In this step, you drill down to view transactions or subtotals 
from your General Ledger data. 

1. Highlight the balance, Cost of Goods Sold. 

2. Right-click, and choose Drilldown from the menu. 
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The Drilldown Type window appears:  

 

3. Choose the Transaction as the drilldown type to view the 
underlying transactions that make up the reported balance. 

4. Click OK. The Drilldown Transaction window appears. 

5. Now repeat steps 1 to three but change the drilldown type, 
selecting Data as the type option, and Database as the data 
option.  

6. Click OK. 

Drilldown 
unsuccessful? 

If the drilldown procedure does not retrieve any data, the 
message, “No segments selected for drilldown” appears. 
Reselect the transactions or subtotals you want to apply the 
drilldown procedure to, and reselect drilldown options. 

Copying and pasting 
drilldown data 

You can copy and paste drilldown data to a word processing or 
spreadsheet program by highlighting the data and selecting 
Copy from the Edit menu, or using CTRL-C to copy and CTRL-V 
to paste. 

Where to Now? 
There are many creative formatting options you can apply to 
your financial statements, such as adding color, borders, and 
shading, or applying your favorite font and size. To find out 
more about these options, see Chapter 5, “Working with 
Statements.” Chapter 5 also covers information about how to 
customize your financial statements by changing defaults. 
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Chapter 5 
Working with Statements 
 

This chapter covers fundamental Financial Link Professional 
concepts and features as well as instructions on how to 
customize statements by defining default settings, properties 
and parameters, and applying formatting options. 

Working with Report Sets 
Definition A report set contains information on what database(s) to use to 

generate a report or statement, what folders have been created to 
store reports and statements, what formatting commands have 
been applied, and the actual names of reports and statements. 

When you start to build a report or statement, Financial Link 
Professional automatically creates a report set for you. As you 
work with your report or statement, the report set is updated. 

Report sets are the basic unit in Financial Link Professional, and 
they are stored as .RPS files.  

Report sets and 
company data 

Report sets do not contain company data. After a report set is 
opened and you sign on, Financial Link Professional retrieves a 
copy of the company data, which appears in the statements and 
reports you preview and print. 

Your company data includes account ranges, balances, and the 
company name. 

If you recalculate or 
change settings 

FL retrieves another copy of the company data automatically 
when you recalculate or change settings.  

Note that company data is not saved into a report set. 
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 A report set can contain one statement or multiple statements for 
one company or any number of companies. You can retrieve 
more than one database into your report set. 

To open a report set: 

1. Select Open Report Set from the File menu. An Open 
window appears. 

2. In the Open window, select the folder that contains your 
report set. 

If you used Financial Link Professional’s defaults, the file 
will be stored in the data source directory where your 
ACCPAC or ACCPAC Plus data is located, and the file will 
have the .RPS extension. 

3. Click the file name. 

4. Click OK. 

Working with Databases 
If you plan to work with data for several companies or use 
different sets of data for the same company, use the Maintain 
Databases window to: 

� Add a new database to use with a statement or report. 

� Delete a database you have set up in Financial Link 
Professional. 

� Change settings such as the current year, number of periods, 
wide quarter, and code. 

� Reload ACCPAC information such as accounts and 
segments. 

� Define and bind database segments for each company 
database you add.  

� Change the location of the company database. 
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About the Maintain 
Databases window 

Select Databases from the Define menu to open the Maintain 
Databases window. This window shows all the databases you 
are currently working with, the number of segments found in 
each, the number of keys (account/segment combinations), and 
whether the current fiscal year is open. 

 

Primary database The arrow points to the primary database. Financial Link 
Professional creates a primary database at the time you open or 
create a report set. 

 Note that you cannot change the primary database. 

New button Click the New button to add a database to your report set. A 
New Database window appears. Click ACCPAC or ACCPAC 
Plus, then click OK. A Database Location window appears. 
Select the location of your data, and click OK. (The chart of 
accounts may be loaded with a Warning indicating that the 
segments in the new database were not bound to any of the 
defined segments.) 

Delete button Click the Delete button to remove any databases you no longer 
want to work with. 

Segments button Click the Segments button to open the Database Segments 
window where you can modify segments. 

Reload button Click the Reload button to reload ACCPAC accounts and 
segments. 

Settings button Click the Settings button to open the Database Settings window, 
where you can change the current year, number of periods, wide 
quarter, and company code. 
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Location button Click the Location button to open the Database Location 
window, where you can specify a different directory and 
selector. If you have changed the location of your ACCPAC or 
ACCPAC Plus data, you need to update the directory path in 
this window. 

Working with Database Groups 

Groups of databases Databases of General Ledger data files can be grouped for 
multiple company consolidations or comparison reporting. Once 
you set up a database group, you can change or delete it.  

To build groups of databases: 

1. Choose Database Groups from the Define menu. The 
Database Groups window appears: 

Database Groups 
window 

 

2. Click the New button. 

The Database Group Definition window appears: 

Database Group 
Definition window 

 

3. In the Name field, enter a name for your group. 

4. In the Code field, enter an abbreviation of the name you 
entered in step 3. 
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5. Use the arrows to add databases to your group. 

6. Click OK. 

Working with Folders 
Folders can be used to hold statements for every segment in 
your database as well as for consolidated segments. Folders are 
flexible and easy to work with. 

All Databases folder When Financial Link Professional creates a new report set, it 
automatically creates a folder called All Databases.  

To add folders: 

1. Select Setup Folders from the Data menu while in the 
Financial Reports window.  

The Add Folders window appears:  

Add Folders window 

 

2. Select one of the options, for example, select Consolidated 
under the Division segment.  

If you choose Consolidated for Regions, Financial Link adds 
one folder, All_Region. If you choose Each Value for 
Regions, Financial Link Professional adds a folder for each 
region defined in your General Ledger. 

3. Click OK. 
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A Confirm window appears: 

  

4. Click Yes. 

In this case, the All Division folder appears in your Financial 
Reports window. 

Understanding Folder Options 

Example To illustrate how these options work, consider the example of 
two companies: ABC Company has Divisions 100 and 200. XYZ 
Company has Divisions 100, 200, and 300. Within each division, 
there are two regions, North and South, for both companies. 

The options and their effects on the example are as follows: 

Datasets options If you choose Consolidated, Financial Link creates one folder 
called All Databases. 

If you choose Each Value, Financial Link Professional creates 
two folders, one for each company. 

Account options This would be marked Ignore for this example, but in a company 
with a different account structure, Financial Link Professional 
adds a folder for one of the reporting segments. 

Division options If you choose Consolidated, Financial Link Professional creates 
three folders, one each for 100, 200 and 300.  

Division folders 100 and 200 would be consolidations of ABC 
Company and XYZ Company.  

Division 300 would only include XYZ Company. 
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If you choose Each Value, five folders are created: 

� Division 100, ABC Company 

� Division 200, ABC Company 

� Division 100, XYZ Company 

� Division 200, XYZ Company 

� Division 300, XYZ Company 

Region options If you choose Consolidated, two folders are created: North, and 
South. 

If you choose Each Value, ten folders are created:  

� For XYZ Company: 

– Division 100, Region North 

– Division 100, Region South 

– Division 200, Region North 

– Division 200, Region South 

– Division 300, Region North 

– Division 300, Region South 

� For ABC Company: 

– Division 100, Region North 

– Division 100, Region South 

– Division 200, Region North 

– Division 200, Region South 

To rename a folder: 

1. Click on a folder to select it. 

2. Right-click to see a pop-up menu. 

3. Choose Folder Prop.  
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The Data Properties window appears:  

Data Properties 
window 

 

4. In the Data Properties for Folder field, type a new name for 
your folder. You can type over the existing name, or select 
the existing name and delete it first. 

5. Click OK. 

In the Financial Reports window, the folder now appears 
with the new name. 

Changing Folder Options 

You can specify options such as page numbering, starting a new 
page and print setup at the folder level. 

When you specify options at the folder level, the options apply 
to all the reports in a specific folder. You can apply printing or 
viewing instructions to a specified statement, to one report 
folder and all its statements, or to all the statements in all the 
report folders.  

To change print and display options for a folder: 

1. Click on a folder to select it. 

2. Right-click to see a pop-up menu. 
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3. Choose Folder Options. The Folder Options window 
appears:  

 

4. Select or deselect these options by clicking inside the check 
box: 

� New page.  If this option is selected, each statement is 
printed on a new page. 

� Number pages from 1.  If this option is selected, 
statement numbering is set to one for each statement. 

� Include in report set print.  If this option is selected, the 
contents of this folder will be printed. If you don’t want 
to print this folder, deselect this option. 

5. Click OK. 

Copying Statements between Folders 

 You can duplicate a statement and copy it to another folder if 
you require the same format for another department, 
organizational segment, or another company.  

Linked versus unlinked 
copies 

Duplicate statements are linked to the original. Whenever 
changes are made to the original, the changes automatically 
apply to the duplicate(s). You can also create a copy of a 
statement that is unlinked.  

To create a linked duplicate: 

1. In the Financial Reports window, click once on the statement 
you want to duplicate. 

2. From the Data menu, choose Reuse Statement. 

3. Select the destination folder(s) where you want duplicate 
statements to appear.  
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To choose more than one folder, click and drag, CTRL-click, 
or SHIFT-click. 

Note:  Any changes you make to duplicated statements are 
reflected in all the statements of the same name.  

To copy a statement that is not a duplicate link: 

1. In the Financial Reports window, select the statement you 
wish to copy by clicking on the statement name. A border 
will appear around the statement to show it is selected. 

2. From the Edit menu on the Financial Link desktop, choose 
Copy. 

3. In the Financial Reports window, select the destination 
folder where you want the statement to be copied. 

4. From the Edit menu, choose Paste. 

The copied statement appears in the destination folder. 

Note:  The new statement has the same name as the original 
statement, but with a trailing –1. 

To copy a statement from one report set to another: 

1. Open the report set that contains the statement you want to 
copy. 

2. In the Financial Reports window, select the statement. 

3. From the Edit menu, choose Copy. 

4. Close the report set you are in, and open the report set 
where you want the copied statement to appear. 

5. Select the destination folder. 

6. From the Edit menu, choose Paste. 

The statement appears in the destination folder. 



Setting Up Account Groups 

User Guide    5–11 

FLP5.doc, printed on 11/18/2002, at 5:59 PM. Last saved on 11/18/2002 5:06 PM. 

ACCPAC INTERNATIONAL, INC. Confidential 

Introd
ucing

 Sim
p

ly 
Introd

ucing
 Sim

p
ly 

Introd
ucing

 Sim
p

ly 
C

ustom
izing 

Statem
ents 

W
orking w

ith 
Statem

ents 

Setting Up Account Groups 
Financial Link Professional allows you to include grouped or 
ungrouped departmental data in your reports.  

Why create account 
groups? 

You can create account groups to condense or consolidate 
General Ledger accounts. If you need to group data for reporting 
purposes, you can easily define a group of accounts.  

Account groups can be used to select and report on accounts that 
are not in sequential order. Account groups are also useful for 
developing more complex queries or formulas. For example, if 
there are three sales areas in your company’s Western Sales 
division, you can group them into a Western division for a 
consolidated statement. (You don’t need to list each department 
consecutively on the report.) 

To define an account group: 

1. Open the Data Properties window by selecting Row Prop, 
Cell Prop, Column Prop or Statement Prop from the Data 
menu. 

2. In the Data Properties window, select Acct from the Data 
selection list. 

The Data Properties window now looks like this:  

Data Properties 
window 
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3. Click the Groups button. The Account Groups window 
appears:  

Account Groups 
window 

 

4. Click the New button. The Group Name window appears:  

Group Name window 

 

5. In the Short Name field, enter a name for your account 
group. Your name can be up to 6 characters long.  

6. In the Full Name field, enter a longer, more descriptive 
name up to 50 characters long. 

For example, if you entered WEST in the Short Name field, 
you might enter WESTERN DIVISION STORES in the Full 
Name field.  

You can also accept the generic default names assigned by 
Financial Link Professional. 

Note that you can rename your account groups at any time. 

7. Click OK. 

8. From the Accounts list in the Accounts Group window, 
select each account you want to include in your new group.  
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You can highlight several accounts, as this illustration 
shows: 

 

To load a range of accounts, double-click on the group name 
and enter the account range separated by a dash, for 
example, 3000-3999. 

9. Click the OK button to save your account group.  

Additional options To remove your account group, click Delete. To rename it, 
click Rename. 

Importing groups To import existing groups from your General Ledger data, 
click the Load ACCPAC button in the Account Groups 
window. 

10. Back in the Data Properties window, use the drop-down 
selection list to choose the account group you have created. 

11. Click OK. 

To change an account description: 

1. In the Statement Design window, right-click the account 
name, and choose Cell Prop.  

The Data Properties window appears. 

2. In Text definition field, type in a new description. 

3. Click OK. 
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Working with Account Segments 
Autobinding applies 
to first retrieved 
database only 

For the first database  retrieved into a new report set, Financial 
Link Professional segments will automatically match those in 
your General Ledger data.  

For example, if you have defined Acct and Dept segments in 
your General Ledger data, they will be bound to Financial Link 
segments Acct and Dept when the report set is created. 

Financial Link Professional does not automatically update its 
segments to match any subsequent changes in your General 
Ledger data. 

If you add segments in General Ledger after Financial Link 
Professional has created a report set, or if you add another 
database with different account segments to your report set, you 
must manually add and bind any new segments in Financial Link 
Professional. 

The process of setting up segments includes:  

� Checking database structures. Use the Financial Link 
Segments window, or choose Segments in the Maintain 
Databases window. 

� Adding Financial Link segments (as required). Use the 
Financial Link Segments window to add segments as well as 
to modify and delete them. 

� Binding segments. Use the Database Segments window. 

To check database segment structures: 

1. Open the Maintain Databases window by choosing Database 
from the Define menu.  

2. Select the database you want to check segments for. 

3. Click the Segments button.  
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The Database Segments window appears:  

 

 

This window lists the number of segments in your data, the 
names of your segments, whether they are bound to 
Financial Link Professional segments, and the number of 
keys (number of values found in ACCPAC).  

4. Click OK or Cancel.  

To add a Financial Link Professional segment: 

1. Choose Segments from the Define menu.  

The Financial Link Segments window appears: 

Financial Link 
Segments window 

 

2. Click the Add Segment button.  

The Edit Financial Link Segment window appears:  

Edit Financial Link 
Segment window 

 

3. Enter the segment name in the Name field. 
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4. Choose the option for unspecified handling to be used if you 
selected the Unspecified option for this segment in the Data 
Properties window when you are building a report or 
statement: 

� Blank.  If you choose Blank, Financial Link Professional 
retrieves data for accounts that only have a blank value 
for that segment in the account code   

� Consolidated.  If you choose Consolidated, which is 
the default option, Financial Link Professional combines 
all values found (including blanks) for that segment in 
the account code into one consolidated figure. 

5. Click OK. 

To bind a segment: 

1. From the Define menu, choose Databases. The Maintain 
Databases window appears. 

2. Click the Segments button to open the Database Segments 
window.  

3. Under Seg #, click on the number of the segment you want 
to bind. 

4. Click the Edit button. The Edit Segment window appears. 

5. Click the arrow next to the Binding field to see a drop-down 
selection list, as shown here, and click on an option:  

Edit Segment window 

 

You can bind the segment to an existing segment in 
Financial Link, or you can choose one of the following 
options:  

� Unbound-consolidated.  Choose this option to allow 
any value found in the segment, including no value, to 
be reported.  
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� Unbound-blank.  This is the default setting.  If you 
choose this option, Financial Link Professional will only 
report accounts that have no value defined for this 
segment, for example, single-segment accounts.  

For example, assume that your chart of accounts includes 
single-segment accounts such as Retained Earnings, and 
your new database segment, “Area,” is unbound-blank. 
Financial Link Professional only returns figures for account 
codes that have a blank Area segment. If the account code 
has any values, for example, Western, or Northern, Financial 
Link will not return values. 

Default settings If you do not specify a segment at any level, from folder, 
statement, row, column, to cell, Financial Link Professional uses 
the default setting, Consolidated-All or Blank. 

Segments and 
templates 

If you are using a template, you should specify Account as the 
first segment in the Financial Link Segments window. If Account 
is not the first segment in your database structure that appears in 
this window, rearrange the segments using the arrow button. 

Financial Link 
Segments window 

 

If you don’t bind a 
newly-added 
segment 

Note that if you don’t bind a new database segment, the segment 
will not appear in the Data Properties window. Data for that 
segment will not be reported in the statements. 

Selecting Segmented Data for Reports 

You can include segments in your reports and statements based 
on the selections you make in the Data Properties window. 
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Segments and Data 
Properties window 

You can specify segment values at the folder level, statement 
level, row level, column or cell level, or, you can leave segment 
values unspecified.  

Choosing the 
Unspecified setting 

If you choose the Unspecified setting in the Data Properties 
window, Financial Link Professional either retrieves data that 
has no value for that segment, or combines all values, depending 
on the Unspecified Handling option you choose in the Edit 
Financial Link Segment window. 

The following example shows an unspecified Area segment: 

 

 

If you chose Blank in the Edit Financial Link Segment window 
when you added the segment, Financial Link Professional only 
retrieves data that has a blank value for that segment in the 
account code. If you chose Consolidated, the default option, 
Financial Link Professional combines all values found (including 
blanks) for that segment in the account code into one 
consolidated figure. 

To group segments: 

1. In the Data Properties window, select the segment you want 
to use to create groups and click the Groups button. 

The selection called All  -ZZZZZZ is set up automatically by 
Financial Link Professional and is used for consolidation 
reporting of a segment.   
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2. Click New. 

3. Enter a Short name code and a Full name.   

4. Click OK. 

5. Select segments to include in your new segment group by 
clicking on a selection in the Segment list. To select several 
segments, double-click on the group name and enter the 
department range separated by a dash, for example, 100-300. 

6. Click OK. 

Setting Global Defaults 
Financial Link Professional allows you to customize global 
default settings for your statements and reports, including: 

� Report dates and reporting periods. 

� Rounding methods. 

� Provisional posting. 

� Source currency reporting. 

� Unit measurements. 

� Formats for numbers, currency and percentages. 

� Page breaks, margins, alignment, and grid lines. 

� Column and row parameters. 

� Borders, fonts and color. 

Default settings Default settings apply to all financial statements in a report set, 
and they form the parameters for designing your statement. All 
default settings can be modified at any level: statement-wide 
defaults, or defaults for rows, columns and cells. 

Setting Figure Defaults 

You can define defaults for the figures that appear in your 
statements, including currency and percent formats. 
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To set defaults for figures: 

1. From the Global menu, choose Figures.  

The Figures Format Defaults window appears:  

Figures Format 
Defaults window 

 

The Figures Format Defaults window displays 
currently-defined default settings for all statements in the 
report set.  

Choose a button to 
specify different 
currency, number, 
and percent settings 

Each button in the Figures Format Defaults window opens a 
new window where you can specify different currency 
formats, number formats, percent formats, and apply 
defaults already established in Windows, ACCPAC or 
ACCPAC Plus. 

2. Click on a button to specify how currency, numbers, and 
percentage symbols appear. 

3. To change the currency symbol, click the Currency format 
button.  

The Currency page appears:  

Currency page 
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4. Define currency options by selecting one of the following 
options from the Currency selection list: 

� Left, Leading or Trailing the Symbol or None.  Choose 
None if you don’t want to use a currency symbol.  

� Currency Symbol.  If you select this option, you can 
use any currency symbol. 

� Space.  This option moves the symbol to the left by one 
space if Leading has been selected.  

If Trailing has been selected, choosing Space moves the 
symbol one space to the right. 

� Outside Neg.  This option place the currency symbol 
outside of the brackets or minus sign. 

� Decimal Separator.  This option is designed for multi-
currency ledgers which use other symbols for 
separators. The default separator is a period, for 
example, $12.94. 

� Group Separator and Size of Group.  These options 
are designed for multi-currency ledgers which use other 
symbols for separators and sizes. The default group 
separator is a comma, for example, $9,876, and the 
default size is 3. (Size determines how many numbers 
appear after the separator.) 

Sign Reversal Choose the Sign Reversal option if you want to report values 
opposite to their sign, for example, to report credits as 
positive values.  

Absolute Choose the Absolute option if you want to report all figures 
as positive, including negative figures.  

5. Click OK after you have selected currency settings.  

6. To change the number format, click the Number Format 
button.  
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The Number page appears: 

Number page 

 
Decimals Use the Up or Down arrows to increase or decrease the 

number of decimals.  

Shift Select Shift to round large numbers when you need to save 
space. For example, if you shift 10,000 –3m the figure is 
reported as 10.  

Negative To represent negative values, choose an option in the 
Negative drop-down selection list:  

� Left.  The chosen negative sign prints to the far left of the 
cell to align with the values in a column. 

� Leading.  The chosen negative sign prints immediately 
to the left of the value. 

� Trailing.  This option applies to the minus sign only, and 
prints it to the right of the values. 

� Minus sign.  

� Brackets (). 

� None. 

� Space.  If you select this option, a space is inserted 
between the end bracket, or trailing dash, or leading 
beginning and ending bracket.  

� Color.  The default color is red, but you can choose from 
the color chart or custom colors by clicking the colored 
button. 
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7. To change the percent symbol, click the Percent Format 
button. 

The Percent page appears:  

Percent page 

 

Options for percentages include the following:  

Decimals.  The value you select determines how many 
decimals are displayed. For example, if you choose 2, two 
decimals will be displayed. 

Shift.   The value you select determines how many positions 
to the right that the decimal place is moved. For example, if 
you choose 2, the decimal place is moved two positions to 
the right (this is the same as multiplying by 100). 

Negative.  If you select Leading ( ) with no Space and no 
Color, Financial Link Professional places parentheses  
around the figure without inserting any spaces between the 
figure and the parentheses. The default color, black, is used. 

Currency.  If you select Left % with Space, Financial Link 
Professional places the % sign on the left, and includes a 
space between the sign and the figure. The Outside Neg 
setting does not apply when using parentheses. 

8. To apply the settings you have defined in ACCPAC, click 
the Set ACCPAC defaults button. 

9. To use the Windows defaults, click the Set Windows 
defaults button.  
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The following Information message appears to notify you 
that Financial Link Professional automatically changed the 
settings to those you have defined in Windows. 

 

 

10. Click OK. 

11. Back in the Figures Format Defaults window, click OK to 
save your changes. 

Setting Global Options for Statements 

Use the Document Options window, shown below, to specify the 
following options for an entire statement or for parts of a 
statement (column, row, or cell): 

 

To open this window, select Options from the Global menu. 
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Global options The global options you can customize to suit your preferences 
include: 

� Date formats. 

� Grid line colors. 

� Unit measurements. 

� Margin increments. 

� Directory where report sets are stored. 

� Whether to include provisionally-posted data. 

� Whether to report data in a currency other than the source 
currency. 

Date formats In the Short Date Format and Long Date Format fields, enter 
codes to specify your preferred date format: 

Code Result 

mm 03 

mmm Mar 

mmmm March 

dd 31 

ddd Tue 

dddd Tuesday 

yy 01 

yyyy 2001 
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Grid lines Financial Link Professional automatically applies a grid to the 
working area of your statement. To change the grid line color 
from the default, gray, use the drop-down selection list to choose 
white, or black grid lines. Choosing white makes the grid lines 
invisible. 

You can change your statement’s foreground or background 
color by select Format from the Global menu, then choose the 
Borders and font tab of the Format window. 

Unit measurements Unit measurements affect column width, row height, and cell 
margins. You can choose between inches, centimeters or points.    

Margin increments Margin increments control the position of contents within a cell. 
Depending on the unit measurement specified on the Document 
options window, these increments will be in inches, centimeters 
or points. The default settings for margin increments are 0.10 
inch, 0.25 cm or 7.20 pt. To change these settings, simply 
highlight the number and enter in a new one. 

Default directory Enter the name of the directory where you want to store report 
sets in the Default Directory field.  

Source Currency 
Reporting option 

Select the Source Currency Reporting option if your General 
Ledger data is multicurrency and you want the source currency 
to be reported.  

Use Provisional Data 
option 

Select the Use Provisional Data option if you want Financial Link 
Professional to include provisionally-posted General Ledger 
data in your financial statement.  

Use Early Rounding 
Method option 

Select the Use Early Rounding Method option if you want 
Financial Link Professional to round your data using the early 
rounding method. For more details about the rounding options 
you can use, see the section, “Working with Rounding Options,” 
later in this chapter.  

To set global options: 

1. From the Global menu, select Options.  
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The Document Options window appears: 

 

 

2. Specify options, and click OK. 

Changing Reporting Period Options 

When Financial Link Professional connects to your data, it 
automatically selects the 13-period option if your data is set up 
with a 13-period fiscal year. Using information from your 
General Ledger data, Financial Link defines the quarter where 
the two periods fall in the same month.  

To change the quarter that reports the extra period: 

1. Choose Databases from the Data menu. The Maintain 
Databases window appears. 

2. Choose the Settings button.  

The Database Settings window appears:  

Database Settings 
window 
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Options You can change the current year, and change the value in the 
Periods field to 12 or 13.  

The Wide Quarter selection list represents the quarter that 
reports the extra period during your fiscal year.  

If you selected 13 in the Periods field, specify the quarter that 
reports the extra period in the Report Periods field. 

Mapping Fiscal Periods 

When you open two or more databases in Financial Link 
Professional, you can print statements that compare two 
companies, even if they do not have the same fiscal year. You 
can align one company’s reporting periods with that of the other. 

In the following example, the first company’s year-end occurs on 
31 December, and the second company’s year-end falls on 
31 March. 

 First Company 

Second Company  

Periods one through three in the first company would be 
mapped to periods ten through twelve of the previous year in 
the second company. 

Warning:  companies 
must have the same 
number of periods 

Although companies do not need to have the same year-end, 
they should the same number of fiscal periods. However, if your 
company has 13 fiscal periods, the other company must also use 
13 fiscal periods. 

To map one company’s fiscal periods to another: 

1. Choose Fiscal Periods Mapping from the Define menu. You 
will see a table that contains each company along with the 
number of financial periods. FP1 represents the first financial 
period, FP2 the second, and so on. 
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2. In the Mapping Year field, select the year that you want to 
compare. 

3. In the Mapping Company field, choose the company that 
will be the basis of the comparison. This company appears in 
the first column, and you cannot change the reporting 
periods for it. 

4. You can now match the reporting periods of the second 
company to that of the first. In the final column, select the 
reporting period for the first company that matches the start 
of the financial year for the second. 

For example, you are comparing two companies with twelve 
reporting periods. The default company’s financial year 
starts in January, while the second company’s financial year 
begins in October. As the second company’s financial year 
starts three months earlier, you would need to select 
reporting periods that started three months earlier, as shown 
in the following example. 
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You can select a financial period in the last, current or next 
year, as indicated in the following table. 

Code Result 

<FP Last year’s financial period 

FP This year’s financial period 

>FP Next year’s financial period 

5. Click Save. 

Rounding Options 
Financial Link Professional uses one of two rounding methods: 
early rounding and late rounding. Both methods will be familiar 
to ACCPAC and ACCPAC Plus users.  

Default rounding 
option 

The default rounding option in Financial Link Professional is the 
early rounding method. 

To change to the late rounding method, select Options from the 
Global menu, and uncheck the Use Early Rounding Method.   

Global rounding You can apply rounding to a particular statement or to all 
statements in a report set. When you apply rounding globally, it 
is reflected in all statements in a report set. When you apply 
rounding at the statement level, it only affects the statement you 
are working with.  

Using Early Rounding Method (Default) 

The early rounding method rounds the figures from each fiscal 
period as it retrieves them from your General Ledger data, that 
is, at the earliest possible time, before using the figures in the 
financial report. The totals for this method always add up 
because they are totals of the printed rounded figures. However, 
totals may not agree with the trial balance totals due to rounding 
errors. 
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Using the Late Rounding Method 

The late rounding method rounds the reported figures after they 
have been retrieved from your General Ledger data to perform 
the rounding at the latest possible time.  

This method gives the smallest possible rounding error. It may 
appear inaccurate in certain reports because the rounded figures 
printed for each fiscal period do not add up to the corresponding 
rounded trial balance figures. 

To specify rounding for reports: 

1. Select Options from the Global menu.  

The Document Options window appears: 

Document Options 
window 

 

2. Select the Use Early Rounding Method option unless you 
want to use the late rounding method. 

3. Click OK. 

To specify the rounding amount for a statement: 

1. Right-click the top left corner of a statement, and choose 
Format from the menu. The Format window appears. 

2. Click the Figures tab (if it isn’t selected already). 

3. Change the Decimals value to 0 by clicking the Up or Down 
arrow until you reach 0. 

4. Change the Shift value to the rounding position you want by 
clicking the Up or Down arrow.  
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5. Click OK. 

Working with Data Properties 
You can set data properties for statements, rows, columns and 
cells as well as for databases, source currency, period balances, 
accounts, and departments. 

Inheritance Data properties are inherited from the highest level they are 
defined at.  

To view properties for part or all of a statement: 

1. Click the portion of the statement on which you want to 
view properties: 

� To select the entire statement, click the gray cell in the 
top-left corner. 

� To select a row, click a gray cell along the left side.  

� To select a column, click a gray cell along the top.  

� To select a cell, click inside it. 

2. Right-click the right mouse button, and choose one of the 
following options from the menu: 

� Statement prop. 

� Row prop. 

� Col prop. 

� Cell prop. 

You can select the same options by choosing Statement Prop, 
Row Prop, Col Prop, and Cell Prop from the Data menu. 
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The Data Properties window appears: 

 

Data selection list When you choose Data under the Type options in the Data 
Properties window, you can define properties for databases, 
currencies, accounts, and segments. 

Options include: 

 � Database.  Choose the From Folder option or choose a 
database you want to work with for your statement.  

 � Currency.  Choose this option to select a currency. You can 
choose to report in the Source currency value or in the Home 
equivalent. Note that source currencies available for 
reporting are restricted by the currency tables you have set 
up in your General Ledger data. 

If you select the Unspecified option in the Data Properties 
window, the source currency data properties will be 
inherited from a higher level. 

� Selector.  Choose this option to define reporting periods. 
When you choose this option, the Data Properties window 
displays a Builder button. Click the button to open the 
Selector Builder window. 

For more details, see the section, “Specifying Reporting 
Periods,” later in this chapter.  
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� Account.  Choose this option to define accounts to report 
and set up account groups.  

Unspecified account 
option 

If you choose the Unspecified option in the Data Properties 
window, shown here, properties for the underlying data are 
inherited from a higher level or are not required. 

 

 

Consolidated or 
Separated group 

To report the account group, choose one of the option 
buttons in the Data Properties window: Consolidated, which 
shows group data condensed on one line or Separated, 
which lists data individually.  

� Segments.  Choose this option to define accounts to define 
the segment reporting and set up segment groups. 

Reporting Dates and Fiscal Periods 
When it comes to working with dates and periods, Financial 
Link Professional allows you to specify the accounting fiscal 
period criteria you wish to report and to change the statement 
reporting date, recalculating balances accordingly.  

To specify a different accounting period: 

1. On the toolbar, select an accounting period in the Fiscal 
Period Selector. 
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2. Click OK. 

To specify a different year: 

1. On the toolbar, select a year in the Fiscal Year Selector. 

2. Click OK. 

To specify a different statement reporting date 

1. Select Statement Date from the Global menu.  

The Statement Date window appears:  

Statement Date 
window 

 

2. In the Statement Date field, select a different date, staying 
within the currently-selected fiscal period. 

3. Click OK. 

Specifying Fiscal Periods 

 Use the Selector Builder window to specify the accounting fiscal 
reporting options. Although the reporting period is usually 
defined at the column or row level, you can define it at the cell 
level. 

Based on the current fiscal period and year you selected from the 
toolbar, the Selector Builder window depicts exact data 
information returned for the chosen row, column or cell. The 
graph depicts the time frame you selected. 

Select reporting 
values 

Click on options to select the desired reporting values. Choose 
the Selector settings from the first five list boxes for the values 
you need to report in the chosen row, column or cell.  
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Selector Builder 
window 

 

Reporting value 
choices 

When it comes to reporting a value, there are three options you 
can choose from:  

� Opening balance. 

� Balance. 

� Net change. 

Choosing the type of 
balance 

Depending on the type of value you wish to report, choose from 
the following balance types:  

� Actual. 

� Actual with provisional. 

� Budget. 

� Quantity. 

� Provisional. 

� Provisional quantity. 

� Quantity with provisional. 

Choosing the 
reporting period and 
timeframe 

Financial Link Professional lets you select monthly, quarterly, bi-
annual and annual reporting periods. Depending on the period 
type, you can choose from additional options:  adjustment (ADJ), 
closing (CLS), current (CURR), first previous to 13th previous 
periods, and specific reporting periods. 
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Choose a year You can choose from the following years: current year, last year, 
2 years ago, three years ago, and four years ago. The actual years 
that appear in this selection list are based on your ACCPAC 
fiscal calendar. 

Additional options for 
specifying periods 

Financial Link Professional offers several other options to choose 
from that narrow or expand the accounting time frame: 

� Aligned.  When you select this option, your reporting data 
is aligned with the fiscal period calendar. (By default, this 
option is selected.) 

When you de-select this option, you can choose quarterly, 
half year or full year reporting that is not aligned with the 
fiscal year.   

For example, a quarterly report at fiscal period 5 would 
include fiscal periods 3, 4 and 5 rather than the conventional 
quarter reporting only periods 4 and 5.   

� Comparison.  When you select this option, Financial Link 
Professional allows reporting only with respect to the 
current fiscal period selection. 

For example, if you select Comparison for a quarterly report, 
with the current fiscal period at 5, the report will show only 
periods 4 and 5.    

If you deselect the Comparison option, you can report 
beyond the current fiscal period. In this example, if you 
deselect Comparison, Financial Link Professional returns 
quarterly data for periods 4, 5 and 6. 

� Include adjustment or include closing.   Use this option if 
you want reports to correspond with the criteria used in the 
selected ACCPAC database. 

� Overlap.  This option allows reporting periods to extend 
beyond the fiscal year calendar, for example, if you want to 
report sales figures for September of year 1999 to June of 
2000 even though the fiscal year-end is in December.  

� RE Bal only.  Use this setting to report the opening balance 
of retained earnings.   
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If there have been current period entries made to the 
retained earnings account during the fiscal year, Financial 
Link Professional will continue to report the opening 
balance if this setting is checked. 

Description line The description displayed below the list and check boxes 
changes with your selections and moves the position of the red 
bar on the graph, depending on your selections. 

Database The Selector Builder window displays the currently-selected 
database. This is view-only; you can’t change the database in this 
window. 

Formatting Reports and Statements 
This section describes formatting capabilities for report sets, 
financial statements, and rows and columns within statements. 

When it comes to formatting, you can control the following 
elements: 

� Margins and alignment of report or statement contents. 

� Borders and cell underlining and overlining. 

� Figures, including currency symbols. 

To format a report set: 

1. Select Format from the Global menu. The Format window 
appears. 
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2. Click the Report Set tab to see options available to you. 

Report set format 
options 

 

3. Click OK. 

Note:  You can set up defaults for every statement in your report 
set by choosing Format from the Global menu. You aren’t 
limited to options on the Report Set tab. 

To format a statement: 

1. Right-click the gray cell in the top left corner of a statement, 
and choose Format from the menu.  

The Format window appears: 

Format window 

 

2. If the Statement tab isn’t already selected, click this tab now 
to see the page alignment and pagination options available 
to you. 

3. Choose options, and click OK. 

Note:  You can set additional defaults for statements on other 
tabs in the Formats window. 
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Formatting Rows and Columns 

Formatting rows The best time to define row parameters is when you start to 
build your statement so that all rows added afterwards will have 
the same parameter formats. You can also format rows 
individually by choosing the row and selecting Row Params 
from the Format menu. 

To format a row within a statement: 

1. Select Row Params from the Format menu or right-click the 
gray cell for the row, and choose Format from the menu.  

The Format window appears. 

2. Click the Row tab.  

The Row page appears: 

 

 

3. Choose from the following options: 

� Height.  Enter the desired row height in inches, 
centimeters or points. Choose units of measure by 
selecting Options from the Global menu. 

� Suppression.  Choose this option to suppress rows if 
they are Null, Zero, or Always. To display suppressed 
rows, select the Reveal All option. 

� Page Break After.  Select this option to create a page 
break after the current row. 
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� Repeat On New Page.  Select this option to duplicate 
column headings or row information on the following 
page(s). 

� Exclude From Calculations.  Select this option to keep 
row values from being included in formula calculations. 
It may be necessary to choose Recalculate from the Data 
menu to see the changes when this option is selected or 
deselected. 

� Report Rounding.  Select this option to report rounding 
errors on this row. 

� Clear Rounding.  Select this option to restart 
accumulating rounding errors at zero. 

4. Click OK. 

Formatting columns 
globally 

You can customize defaults for all column settings in a report set 
by choosing Format from the Global menu and selecting the 
Column tab.  

Formatting columns 
individually 

You can format columns individually by selecting a column and 
choosing Column Params from the Format menu. Set the column 
parameters at the start of a statement build so that all columns 
added afterwards will have the same parameter formats. 

To format columns: 

1. Right-click the gray cell in the top left corner of the 
statement, and choose Format from the menu.  

The Format window appears. 

2. Choose from the following column parameters: 

� Width.  You can change the width of the column in 
inches, centimeters, or points. To change units of 
measure, select Options from the Global menu. 

� Suppression.  Financial Link Professional allows you to 
suppress columns by selecting Null, Zero, or Always.  

To display suppressed columns, select the Reveal All 
option. 
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� Page Break After.  To create a page break after the 
current column, select this option. 

� Report On New Page.  Select this option to duplicate 
the current column on the following page or pages. 

� Exclude From Calculations.  Select this option to keep 
column values from being included in formula 
calculations.  

It may be necessary to use Recalculate from the Data 
menu to see the changes when this option is selected or 
deselected. 

� Report Rounding.  Select this option to specify report 
rounding errors for a column.  

� Clear Rounding.  Select this option to restart the 
accumulation of rounding errors at zero. 

3. Click OK. 

Alignment, Margins and Span 

You can apply many of the alignment, span and margins options 
by choosing a button in the Design Toolbar, shown here: 

 
Alignment You can align the contents of cells, rows, or columns using the 

alignment options in the Format window: 
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Horizontal options include left justification, right justification, 
and centering. Vertical options such as top, bottom, and center, 
control the position of the contents within a cell. 

Span options Contents can span across several cells, across the statement or 
across the page.  

Select these choices from the Span section.  

For example, choose Cells to span multiple columns, then enter 1 
in the Shift box to move the contents to the next cell to the right, 
then enter 3 in the Across box to span the heading across the 
next 3 cells. 

Margins You can change the left and right margins to adjust the 
placement of contents in cells. 

Borders, Underline, and Overline 

Using the Format window, you can add a border to cells as well 
as add a line to the top or bottom of the cells.  

Click the Borders and Font tab in the Format window to see the 
options available to you in the Borders and Fonts page: 

 

When it comes to underlining or overlining a cell, your options 
include: 
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� Full.  If you choose this option, the line extends from one 
side of the cell to the other. 

� Margins.  If you choose this option, the line uses the margin 
settings defined on the Alignment window. 

� Inside.  If you choose this option, the line appears inside the 
currency sign, if you are using a leading currency and the 
right bracket. 

� Contents.  If you choose this option, the line extends only to 
the cell contents, which is useful for underlining headings. 

Insert Images 
You can insert an image into any cell of a statement. 

1. Right-click the cell into which you want to insert an image, 
and select Cell Prop from the pop-up menu. 

2. In the Type section, select the Bitmap option. 

3. Click the Load button. 

4. Use the Open dialog box to find the image file, and then 
click Open. 

5. Click OK. 

Printing Reports and Statements 
Financial Link Professional provides several options for printing 
or previewing your reports or statements:  

� You can print or preview all the statements in all the report 
folders for the entire report set. Specific folders can be 
excluded. 

� You can print or preview all the statements in the selected 
report folder. 

� You can print or preview a selected statement. 
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� You can print or preview multiple statements chosen from a 
list of all statements. Assign your selection a name so that it 
can be reused. 

To select print and print preview options: 

You use the same window, Print Mode, to set print preview 
options and print options. 

1. To open the Print Mode window, click the Print or Print 
Preview button on the toolbar, or choose Print or Print 
Preview from the File menu.  

The Print Mode window appears: 

Print Mode window 

 

2. Select one of the following options: 

� Report set.  Choose this option to select every statement 
in a report set. You can exclude specific folders. 

� Folder.  Choose this option to select all statements in a 
report folder. 

� Statement.  Choose this option to print or preview the 
selected statement. 

� Multiple Statements.  Choose this option to print or 
preview more than one statement. To choose statements, 
scroll through the drop-down selection list, and click 
statement names. 

3. Click OK. 
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Setting Up Printsets 

A printset is a print job for a group of statements.  

To set up a printset: 

1. From the File menu, choose Print or Print Preview. 

2. In the Print Mode window, select Multiple Statements. 

3. Check the boxes beside the statements that you want to 
include in the printset. 

4. Click the Save As button, and enter a name in the Printset 
Name field. 

5. Click OK. 

The Printset has now been included in the box to the left of 
the Save As button and can be selected whenever you choose 
the Multiple Statements option. 

6. Click OK in the Print Mode window. 

To select the printer or print mode: 

1. Select Print Setup from the File menu.  

2. Specify the printer, orientation, paper, or additional print 
options. 

3. Click OK. 

Printing the Contents of a Folder 

To select print options for folders: 

1. Right-click a folder or statement, and choose Folder Options 
from the menu. The Folder Consolidated Department 
Options window appears: 
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2. Select one or more options. 

3. Click OK. 

To specify statement print settings: 

1. Click the gray cell in the top left corner of a statement. 

2. Select Statement Params from the Format menu. The Format 
window appears: 

 

3. Set page breaks, the position, and orientation of the 
statement on the page.  

The Left Margin option is specific to each statement, and it is 
used to center narrow statements in a report set. The total 
left margin setting is a combination of the Global left margin 
option and this option.  

4. Click OK. 

Where to Now? 
Topical online help is available to guide you through specific 
functions and explain windows. To see an online help, click the 
Help button in a window, or go to the Help menu. 
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Appendix A 
Financial Link Professional 
Administration 
 

This appendix is intended for system administrators or 
individuals responsible for supporting Financial Link 
Professional. It covers how to set up new users and define 
security access, as well as set up the Signon utility. 

How you set up your security depends on whether you are 
creating statements with ACCPAC Plus or ACCPAC Advantage 
Series data. 

Security with ACCPAC Advantage Series Data 
Setting up security with ACCPAC Advantage Series data is a 
two-step process. First, you must create users in your Advantage 
Series data, and then you can assign these users to specific 
groups in Financial Link Professional. 

Adding Users 
1. Open your data in ACCPAC Advantage Series, and under 

Administrative Services, use the Users window to create the 
users who will access the data in Financial Link Professional. 

2. Create a Security Group using any Group ID, such as 
FINLINK. Grant this group Journal Entry Inquiry rights 
under the General Ledger application. This option gives 
users the right to use the drilldown feature in Financial Link 
Professional. 

3. Under User Authorizations, assign each user to the Security 
Group you created in step 2 for General Ledger. 



Security with ACCPAC Advantage Series Data 

A–2    Financial Link Professional 

FLPA.doc, printed on 11/18/2002, at 6:06 PM. Last saved on 11/18/2002 6:06 PM. 

ACCPAC INTERNATIONAL, INC. Confidential 

For more information on adding users and group, refer to your 
ACCPAC Advantage Series documentation. 

Administering User Groups and IDs 

 There are two levels of access available to Financial Link 
Professional users, depending on which you assign:  

� View.  This level of access restricts Financial Link 
Professional users to viewing and printing statements. Users 
who have view-only access rights cannot modify or create 
statements and report sets. 

� Design.  This level of access allows unrestricted use of 
Financial Link Professional. 

Creating User Groups 

You must create groups of access rights, and then you can assign 
ACCPAC Advantage Series users to those groups. 

1. From the Define menu, choose Databases. 

2. Select the database for which you want to set up security, 
and click the Security button: 

 

3. Type a new Group ID and description. 

4. Select whether you would like to grant the users who will be 
assigned to this group Design or View rights. 
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5. Click the Save button. 

6. Repeat steps 3-5 for each group you wish to create, and then 
click the Save button. 

7. Click the Close button. 

Assigning Users to a Groups 

Once you have created the appropriate groups, you must assign 
each user to a group. 

1. From the Global menu, choose Security. 

2. In the User ID field, select one of the users you created in 
ACCPAC Advantage Series. 

3. In the Group ID field, select the appropriate group. 

4. Click the Save button 

5. Repeat steps 2-4 for each user. When you have finished 
adding Groups, click the Close button. 

Security with ACCPAC Plus Data 
When you install Financial Link Professional, it automatically 
creates the user SYS (the system administrator), with the 
password SYS. Note that for security reasons, you cannot give 
other users the same security rights as SYS. 

To prevent unauthorized access, you must change the password 
for user SYS using the User Setup program as soon as you have 
installed Financial Link Professional. 

To change the password for user SYS: 

1. From the Windows Start menu, select Programs, then 
Financial Link Professional, and choose User Setup. 

2. In the Signon window, type SYS both in the Initials field and 
in the Password field, and click OK. 
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After a few seconds, the User Setup window appears: 

User Setup window 

 

3. In the User Initials field, select SYS from the drop-down 
selection list. 

4. Click the Edit button. 

5. Type your name in the User Name field. (This step is 
optional.) 

6. In the Password field, type a new password.  

The password is encrypted in the user file and cannot be 
decoded without the Setup program. 

7. Leave the Class field (security access class) blank, since it 
does not apply to user SYS. 

8. Click the Save button. 

To log out of User Setup: 

� Choose Exit from the File menu to automatically log out. 

If you are using other ACCPAC Options products, you will 
be logged out when you exit the last Options program you 
were running.   

To log in again, double-click the User Setup icon and follow 
the instructions above. 
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Setting Network Access Rights 

For additional 
security, set network 
access rights 

We recommend you set read-only network access rights to the 
EZCOMFIL.LD4 file in your data directory as well as to the 
EZUSRFIL.LD4 file in your EZTASKS directory for all users 
except SYS. (When you start the setup program, EZUSRFIL.LD4 
will be created automatically.) 

If you forget the 
password for user SYS 

If you forget the password for user SYS, the only way to 
re-create the password is to delete the user ID record for user 
SYS, and re-create all users and their passwords. 

To delete the user SYS file: 

1. Ask all users who have signed on to Financial Link 
Professional to exit the applications they are running. 

2. Delete the file EZUSRFIL.LD4 from the directory specified in 
the EZCOMFIL.LD4 file in your data directory.  

3. Change the password for SYS (as described above). 

4. Set network access rights (not the file attributes) for the 
EZUSRFIL.LD4 file to read-only. 

5. In the User Setup window, re-create all users, their 
passwords, and security class assignments. 

6. Set the network access rights to read-only except for user 
SYS. 

Administering User Classes and IDs 

 There are two levels of access available to Financial Link 
Professional users, depending on which you assign:  

� View-only.  This level of access restricts Financial Link 
Professional users to viewing and printing statements. Users 
who have view-only access rights cannot modify or create 
statements and report sets. 

� Design.  This level of access allows unrestricted use of 
Financial Link Professional. 
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Creating User Classes 

You must create classes of access rights before you can assign 
access rights to Financial Link Professional users. 

To create security access classes of users: 

1. In Financial Link Professional, open a report set. 

From the Global menu, choose Security. The Security Levels 
window appears: 

 

2. In the Security Levels window, select a Dataset, and click the 
Edit button. You may be warned that no security exist for 
the Dataset. Click Yes. 

The Security Setup window appears: 

 

3. Click the New button under Design Classes or View-Only 
Classes, depending on the type of class you want to create.  

4. Type the name of your user class in the Enter Class Name 
field, and click OK. 

In the Security Setup window, your new user class appears 
in the Design Class or View-only Class box.  



Security with ACCPAC Plus Data 

User Guide    A–7 

FLPA.doc, printed on 11/18/2002, at 6:06 PM. Last saved on 11/18/2002 6:06 PM. 

ACCPAC INTERNATIONAL, INC. Confidential 

Adm
inistration 

5. If you need to create additional classes, repeat steps 3 to 5. 

The following example shows two user classes, Level1 and 
Level2: 

 

6. When you have finished creating classes, click OK. 

Deleting user classes You can delete a user class at any time by selecting the name in 
the Design Classes or View-Only Classes list and clicking the 
Delete button. 

Creating User IDs 

Once you have set up security classes, run User Setup to create 
user IDs. A User ID is a record which contains a user name, the 
user’s initials, a password, and the access class which the user is 
assigned to. 

To create a user ID: 

1. From the Windows Start menu, select Programs, then 
Financial Link, and choose User Setup. 

The User Setup window appears: 

User Setup window 
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2. In the User Initials field, type up to three characters 
representing the user’s initials, and press Enter. The initials 
will appear in upper case. 

User Setup checks to see if these initials have already been 
assigned to another user. If the initials have been assigned, 
the user’s record will appear in this window. 

If they have not been assigned, an Information window will 
appear, asking if you want to add a new user: 

 

3. Click Yes. 

4. In the User Setup window, type the user’s entire name in the 
User Name field, and press Enter or Tab. 

5. In the Password field, type a password, and press Enter or 
Tab. (Passwords are not case-sensitive.) 

Note:  The password is encrypted in the user file, and 
cannot be decoded. 

6. In the Class field, type the name of the class you wish the 
user to be assigned to. 

7. Click the Save button. 

8. To add another user ID, type information into the fields. 

Changing or deleting 
user IDs 

You can edit or delete the user ID you have created by clicking 
the Edit or Delete buttons, respectively. 

Administering the Signon Utility 
What is Signon? The Signon utility verifies each Financial Link Professional user 

and keeps details about the user in memory to ensure secure 
access to data. After a user exits Financial Link Professional, 
these details are unloaded from memory. 
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You run Signon only once during a Windows session. The 
security level granted by Signon is shared by all ACCPAC 
Options applications that use Signon. 

How Signon works The first time a user tries to connect to General Ledger data in 
ACCPAC or ACCPAC Plus from Financial Link Professional, 
Financial Link Professional checks to see whether Signon has 
been run, for example, by another application that requires it.  

If Signon has not been already run during the user’s session, it 
requests the user’s initials and password before allowing the 
user access to General Ledger data.  

File checking: 
EZTASKS.LD4 file 

 

When Signon is run for the first time, it checks to find the 
location of the EZTASKS.LD4 file. This file is used to determine 
who is logged in and which application(s) they are using. If the 
file cannot be found, or more than one copy is found, Signon 
prompts the user to choose the path to the correct EZTASKS.LD4 
file. 

Automatic startup After a user exist Financial Link Professional or logs off 
ACCPAC or ACCPAC Plus, Signon automatically starts the next 
time the user wants to connect to General Ledger data from 
Financial Link Professional in this Windows session. 

Setting the Signon Path 

Setting path to 
EZTASKS.LD4 file 

For Signon to work, you must set the path to the EZTASKS.LD4 
file. The path to the EZTASKS.LD4 file is stored in the 
EZCOMFIL.LD4 file in your data directory. 

Set the path to the drive on which ACCPAC Plus is installed, 
followed by the path indicated in the \ASP\PROFILE.LD4 file. 
(This is the ACCPAC Plus file that contains the location of 
EZTASKS.LD4.) For example, the path to the EZTASKS.LD4 file 
is F:\ASP if ACCPAC Plus is on drive F and the first line of the 
PROFILE.LD4 file in F:\ASP reads \ASP.  

For more details on 
PROFILE.LD4 

See your Windows System Manager documentation for more 
information on the PROFILE.LD4 file. 
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Setting path to 
currency files 

When Signon is run for the first time, it prompts you to choose 
the path to the correct set of currency files that ACCPAC and 
ACCPAC Plus use to store currency information such as the 
currency symbol, and the number of decimals.  

The currency files are usually located in the \ASP directory of 
the drive on which ACCPAC is installed, but they may be 
located in a different directory, depending on the C parameter 
on your command line when you start ACCPAC or ACCPAC 
Plus. 
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Index 
 

 

A 

Account groups, 5–11 
consolidated, 5–34 
long name, 5–12 
setup, 5–11 
short name, 5–12 

Account Groups window, 5–12 
Account segments, 5–14 
Accounting period 

defining, 5–35 
ACCPAC data, 2–1 
ACCPAC Plus 

specification files, 2–10 
working with, 2–6 

Activation code, 1–2 
Add Folders window, 5–5 
Add to Folders window, 2–10 
Alignment 

row, 4–20 

B 

Balance 
actual, 5–36 
actual with provisional, 5–36 
budget, 5–36 
provisional, 5–36 
provisional quantity, 5–36 
quantity with provisional, 5–36 

Binding segments 
options, 5–16 

Borders, 5–43 
Button names, 2–12 

C 

Cell contents, 2–17 
Cell information, 2–17 
Cell Information window, 2–17, 4–16 
Column 

inserting, 4–4, 4–6 
labels, 2–17 
new, 4–6 

Column parameters, 5–41 
Comparison reporting, 5–37 
Connecting to data, 2–3 
Convert Specifications window, 2–10 
Converted statements, 2–11 
Converting ACCPAC Plus Data, 2–10 
Copying statements 

from one report set to another, 5–10 
no duplicate link, 5–10 

Creating statements from scratch, 4–1 

D 

Data properties, 5–32 
databases, 5–33 
databases, accounts, and segments, 5–33 
defining account groups, 5–34 
defining accounts, 5–34 
defining reporting periods, 5–33 
inheritance, 5–32 
specifying currencies, 5–33 
viewing, 1–2 

Data Properties window, 4–5, 4–6, 4–9, 4–11, 
4–14, 5–8, 5–11, 5–33 
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Database 
groups, 5–4 
primary, 5–3 

Database Groups window, 5–4 
Database Location window, 4–2 
Database Segments window, 5–15 
Database Settings window, 5–27 
Databases Group Definition, 5–4 
Date formats, 5–25 
Default settings 

report set, 5–20 
Defining text, 4–9 
Design Toolbar, 2–13 
Desktop, 2–12 
Drilldown, 1–2, 4–22 
Drilldown Transaction window, 4–23 
Drilldown Type window, 4–23 

F 

Features, 1–1 
Figures Format Defaults window, 5–20 
Files 

RPS, 2–15 
Financial Link 

opening, 2–1, 2–6 
startup, 2–1 

Find Dataset window, 2–7 
Fiscal period 

options, 5–35 
Fiscal periods, 5–28 
Folder Options window, 5–9 
Folders, 2–13 

All databases, 5–5 
Format headings, 4–11 
Format window, 4–5, 4–9, 4–12, 4–20, 5–20 

number setting, 5–21 
percent setting, 5–23 

Formatting, 1–1, 4–23, 5–38 
border, 4–20 
column parameters, 5–41 
row parameters, 5–40 

Formulas, 1–2, 4–19 

G 

General Ledger accounts 
consolidating, 5–11 

General Ledger data, 1–1 
connecting to, 2–3 

Global default settings, 5–19 
currency, 5–19 
figures, 5–19 

Grid lines 
changing color, 5–26 

Group Name window, 5–12 
Groups of companies, 1–2 
Groups of databases, 5–4 

H 

Hints, 2–12 
Horizontal and vertical. See:  Alignment 

I 

Images, 5–44 

L 

Label, 2–17 
Landscape print mode, 5–46 
Launching Financial Link, 2–1, 2–6 
Long name for account group, 5–12 

M 

Maintain Database window, 2–4, 5–3 
Mapping fiscal periods, 5–28 
Margins, 5–43 
Menus, 2–17 
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Index 

Multi-currency 
path to currency files, A–10 

N 

New Database window, 2–3 
Number 

setting, 5–21 
Number format, 4–12 
Number setting 

decimals, 5–22 
Number setting 

negative values, 5–22 
rounding, 5–22 

O 

Online help, 2–15, 2–17 
Overview, 1–1 

P 

Page breaks 
multi-column, 5–42 

Percent formats, 5–23 
Pictures, 5–44 
Pop-up menu, 2–16 
Portrait print mode, 5–46 
Preview modes 

landscape or portrait, 5–46 
Preview options 

folder, 5–46 
Previewing statements and reports, 5–44 
Print mode 

landscape or portrait, 5–46 
Print Mode window, 4–21, 5–45 
Print options 

folder, 5–46 
Printed statement, 4–22 
Printing statements, 4–21 
Printing statements and reports, 5–44 

R 

Report set, 4–1 
Report sets 

default directory for storing, 5–26 
Reporting 

departmental, 1–2 
Reporting balances, 5–36 
Reporting fiscal dates, 5–34 
Reporting period 

specifying, 5–27 
Reporting periods, 5–36 
Reporting value options, 5–36 
Reporting values 

absolute, 5–21 
credit or debit, 5–21 

Reports 
creating, 1–1 
parameters, 1–1 

Rounding 
early rounding method, 5–30 
global, 5–30 
late rounding method, 5–31 
to the nearest, 5–31 

Rounding large numbers, 5–22 
Rounding method, 5–26 
Rounding methods, 5–30 
Row 

changing height, 4–16 
inserting, 4–14, 4–17 
labels, 2–17 

Row parameters, 5–40 
Rows 

data, 4–13 
text, 4–7 

S 

Sample statement, 2–11 
Sample statements, 2–14 
Security 

ACCPAC Advantage Series data, A–1 
ACCPAC Plus data, A–3 
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Segments, 2–5, 5–14 
binding, 5–16 
binding options, 5–16 
Database Segments window, 5–15, 5–16 
default settings, 5–17 
Edit Financial Link Segment window, 

5–15 
Financial Link Segments window, 5–15 
specifying values, 5–17, 5–18 
structure, 5–14 
unbound, 5–14 
unbound blank, 5–17 
unbound-consolidated, 5–16 
unspecified, 5–18 
unspecified handling, 5–16 

Segments and reports, 5–17 
Segments and templates, 5–17 
Selector Builder window, 4–6, 5–35 

balance selections, 5–36 
reporting value options, 5–36 

Short name for account group, 5–12 
Signing on to data, 2–4 
Signon 

passwords, A–3 
Signon utility, 2–5 
Signon window, 2–4 
Startup instructions, 2–1 
Startup options, 2–2, 2–6 
Statement 

blank, 4–4 
column, 4–4 
creating, 4–4 
formulas, 4–19 
grid lines, 5–26 
headings, 4–8 
including provisionally posted data, 5–

26 
margin increments, 5–26 
new, 4–4 
number format, 4–12 
pop-up menu, 2–16, 4–4 
reporting period, 5–27 
rounding method, 5–26 
rounding to the nearest, 5–31 
row height, 4–16 
specifying currency, 5–26 

Statement (continued) 
specifying fiscal period, 5–35 
totals, 4–15, 4–18 
unit measurements, 5–26 

Statement color 
foreground or background, 5–26 

Statement Date window, 5–35 
Statement Design window, 2–15, 4–8, 4–9, 4–

15 
repositioning, 2–16 

Statement reporting date 
example, 2–11 

Statements 
alignment, 4–20 
copying, 5–9 
copying to report sets, 5–10 
data rows, 4–13 
duplicating, 5–9 
handling zero balances, 4–18 
inserting text row, 4–7 
printing, 4–21 
renaming, 4–21 
specifying dates, 4–11 

Symbols 
dollar sign, 4–19 

T 

Templates 
12 Month or Departmental Analysis, 3–1 
Accountants Annuals, 3–1 
adding to folders, 3–6 
Management Statements, 3–1 
opening, 3–2 
Professional Quality, 3–1 
styles, 3–1 
Traditional Format, 3–1 
viewing samples, 3–2 

Templates window 
choose style, 3–3 
define account groups, 3–4 
select columns, 3–4 
select statement, 3–3 
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Index 

Toolbar, 2–12 
button names, 2–12 

Tutorial, 4–1 

U 

Underline and overline, 5–43 
Unit measurements, 5–26 
User Guide 

overview, 1–4 

W 

Welcome window, 2–2, 2–6 
suppressing, 2–3 

Z 

Zero balances, 4–18 
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